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Boson NetSim Overview
The Boson NetSim® Network Simulator®, which includes the Boson Router Simulator®, is unique compared to all 
others on the market because of the functionality it supports and its features. NetSim utilizes Boson’s proprietary 
Network Simulator, Router Simulator®, and EROUTER® software technologies, along with the Boson Virtual 
Packet Technology® engine, to create individual packets. These packets are routed and switched through the 
simulated network, allowing NetSim to build an appropriate virtual routing table and simulate true networking. 
Other simulation products on the market do not support this level of functionality.

NetSim is a Windows®-based product that simulates a wide variety of Cisco® routers, including the 2500 series, 
2600 series, 2800 series, and 3600 series routers, as well as the Cisco Catalyst 1900 series, 2900 series, and 
3500 series switches. NetSim supports multiple routing protocols, including RIP, IGRP, EIGRP, BGP, and OSPF. 
It supports different LAN/WAN protocols, including PPP/CHAP, ISDN, and Frame Relay. The labs in NetSim 
require only the devices and functionality included with NetSim—they do not require access to any external router 
or switch hardware. NetSim supports many, but not all, of the IOS commands available on a physical router or 
switch. All of the commands referenced in the available labs are supported by NetSim.

Achieving Cisco CCENT®, CCNA®, or CCNP® certification is the goal of many people who use this product. The 
Boson NetSim covers not only the SWITCH (642-813), TSHOOT (642-832), and ROUTE (642-902) certifications 
but also the ICND1 (100-101), ICND2 (200-101), and CCNA (200-120) certifications, among others. The included 
labs guide you through the configuration of routers, switches, and workstations in a variety of scenarios. Installed 
labs are made available (unlocked) depending on the activation key used to activate the product. All labs are 
downloaded and kept up to date after installation regardless of the activation key used; however, the only labs 
that are available are ones that have been unlocked with the associated activation keys.

Activation keys unlock labs and increase the number of available commands. Beginning with the Demo version 
of NetSim 11, the command set is limited to those necessary to perform the steps in the lab. For example, if 
you start your studies with a CCENT activation key, you will have the command set and labs available that are 
necessary to study for that exam. When you are ready to study for either the CCNA or CCNP exam, you will need 
to purchase a new activation key and activate NetSim with the new CCNA or CCNP activation key; then, more 
labs and a larger command set become available. 

Some of the labs available in the Sequential lab pack when a CCENT activation key has been used to activate 
NetSim 11 are shown in the following graphic. A CCENT activation key also unlocks a selection of labs from the 
Stand-Alone and Scenario lab packs. A small lock icon ( ) is displayed next to unavailable labs. Higher-level 
activation keys allow you to work through all labs unlocked by lower-level activation keys. All demo, CCENT, 
CCNA, and CCNP labs are unlocked when a CCNP-level activation key is used. Some lab packs are delivered by 
NetSim to support other products that are sold separately. If you have questions about locked labs, please contact 
support@boson.com.

mailto:support@boson.com
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After you load and complete an unlocked lab, you can use the grading function in NetSim to grade the lab so that 
you can determine whether you completed it correctly. As you progress through the labs, you can master the skills 
needed to pass the simulation questions in the Cisco certification exams. NetSim has the ability to guide and 
grade, and using it for practice can be more helpful than using real routers and switches. NetSim allows you to 
gain experience without requiring you to purchase expensive equipment.

You can use the Boson NetSim to work through labs, but you can also use it for additional purposes. The included 
full version of the Network Designer tool allows you to practice designing and planning a network. This tool’s 
functionality goes beyond that of most tools because you can actually create the router configurations that are 
going to be used, save those configurations, and practice using them on simulated devices.

Routing protocol implementation is one of the more challenging tasks you might encounter. Troubleshooting a 
production network can be a frustrating experience. Fortunately, you can create a virtual copy of your network 
topology by using the Boson Network Designer and troubleshoot the problems without interfering with your 
production network. Because NetSim is designed as a study tool for Cisco certification, you should not rely only 
on NetSim to make decisions about a production network, but you might find it useful in your troubleshooting 
efforts.

In summary, Boson NetSim is a flexible and powerful product that can help you become certified and, in some 
cases, it can be used to create a simulation of the topology of your corporate network and help you practice 
troubleshooting without using devices on the production network.
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Using NetSim to Prepare for Your Certification
By using NetSim to help you achieve a Cisco certification, you can learn and master the skills necessary to help 
you successfully complete your certification track. The purpose of NetSim is to help you with the practical, hands-
on portion of your education and to ensure that you not only understand the concepts of routing but can actually 
configure and implement routing on Cisco devices.

Mastering Cisco networking involves two fundamental tasks: 

1. Learn the theory of routers and switches.
2. Gain the hands-on experience of implementing that theory by configuring the devices in a network and 

testing them in a lab.

Self-studying for a Cisco certification can be a daunting task. The amount of information a CCNA candidate is 
required to know and the skills that candidate is required to possess are quite extensive. To begin learning the 
theory of configuring a network, you can find a good reference book or listen to an instructor. (Boson Training, 
www.boson.com/boson-training, offers a full slate of classes and Bootcamps.) But a reference book might not be 
enough. The book will not give you the practical, hands-on experience of routing and switching that you can learn 
from NetSim—experience that will help you build on the theoretical knowledge you learned from the reference 
book.

Real equipment gives you the ability to practice on physical routers and switches, but it also is a very costly 
way to practice and leaves a lot of room for error. The Boson NetSim, on the other hand, is an excellent tool to 
help you prepare for the CCNA (www.boson.com/certification/CCNA) and CCNP (www.boson.com/certification/
CCNP) exams. NetSim simulates the behavior of a network and does not just return preprogrammed responses 
to expected command inputs. It allows you to create virtual packets and virtual frames that will be routed and 
switched through the simulated network. Aside from physically plugging in the cables and listening to the 
fan noise, your experience with the simulated network will be much the same as your experience with a fully 
functional lab rack without the expense of the hardware. NetSim will enable you to practice various configurations 
and master helpful skills.

Once you feel you have mastered both the theory (www.boson.com/boson-training) and the practical labs (www.
boson.com/netsim-cisco-network-simulator), you can test your knowledge by using the Boson ExSim-Max 
practice exam products available at the ExSim-Max home page (www.boson.com/exsim-max-practice-exams). 
Boson ExSim-Max products include complex multiple-choice questions, drag-and-drop questions, Boson NetSimX 
simulation questions, and trouble tickets.

The Boson NetSim Network Simulator is the most comprehensive product on the market for learning how to 
configure a Cisco router. The Boson NetSim will not only help you become certified, it will help you learn and 
understand how to configure routers, switches, and networks.

www.boson.com/boson-training
www.boson.com/certification/CCNA
www.boson.com/certification/CCNP
www.boson.com/boson-training
www.boson.com/netsim-cisco-network-simulator
www.boson.com/exsim-max-practice-exams
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Contact Information
EMAIL: support@boson.com
PHONE: 877-333-EXAM (3926)
 615-889-0121
FAX: 615-889-0122
ADDRESS: 25 Century Blvd. Ste. 500
 Nashville, TN 37214

Copyright © 1996 – 2017 Boson Software, LLC. All rights reserved. NetSim software and documentation are 
protected by copyright law.

NetSim Technical Support
• To review NetSim support topics, go to the NetSim Products Support Topics page (www.boson.com/

support/netsim-support-topics).
• To submit a support ticket, go to Boson’s Web site (www.boson.com) > log in to your account > click the 

Support Tickets tab > start a new ticket. 

License Solutions
• Single-User License Agreement (SULA) – You can review the SULA here (www.boson.com/sula).
• License Server – For our unique license-server solutions and volume discounts, contact us at www.

boson.com, 877-333-EXAM (3629) or support@boson.com. 

mailto:support@boson.com
http://www.boson.com/support/NetSim-Support-Topics.html
http://www.boson.com/support/NetSim-Support-Topics.html
http://www.boson.com/support/NetSim-Support-Topics.html
www.boson.com
www.boson.com/sula
www.boson.com/sula
www.boson.com
www.boson.com
mailto:support@boson.com
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Getting Started

System Requirements
Supported operating systems: Windows 10, Windows 8, Windows 7, Windows Vista
.NET Framework: Microsoft .NET Framework Version 4.0
Processor: 1-GHz Pentium processor or equivalent (minimum); 3-GHz Pentium processor or equivalent 
(recommended)
RAM: 512 MB (minimum); 2 GB (recommended)
Hard Disk: Up to 200 MB of available space
Display: 1024 x 768, 256 colors (minimum); 1024 x 768 high color, 32-bit (recommended)
Active Internet connection

Product Activation
You must have a Boson account to download the NetSim Demo. To create a free account, visit the Boson Online 
Account page (www.boson.com/Account/Default.aspx) and enter a valid e-mail address to begin creating an 
account.

You can open NetSim from the shortcut installed during the download or from the Start menu by clicking Boson 
Software > Boson NetSim 11.0 > Boson NetSim. If you are a student using NetSim 11 at a learning institution, 
you should launch NetSim 11 from the Start menu by clicking Boson Software > Boson NetSim 11.0 > Boson 
NetSim LS Client. This will enable you to configure NetSim 11 to authenticate with the Boson NetSim License 
Server.

When you first open NetSim, you will be presented with the NetSim Activation Wizard dialog box. You can select 
the Demo version of NetSim or a full version of NetSim.

•
•
•

•
•
•
•

https://www.boson.com/Account/Default.aspx
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Demo Version
Demo mode launches NetSim with limited commands for evaluation purposes. You will be asked to select how 
you are connected to the Internet. If you are using a proxy server, you must configure the appropriate settings.

When prompted, enter the e-mail address and password associated with your Boson.com account. If you have 
not previously created a Boson.com account, you can create one through the NetSim Activation Wizard.

Within the Demo version of NetSim, only a few labs and commands are available. If you would like to access 
additional labs and commands, you must activate a full version of the Boson NetSim.

If you have not purchased an activation key for NetSim, you will not be able to activate the full version of NetSim. 
However, you can choose to continue in Demo mode. When you are running the Demo version, only the Demo 
labs and a limited set of commands are functional. To purchase the full version of NetSim, visit the About NetSim 
page (www.boson.com/netsim-cisco-network-simulator) of the Boson Web site.

Full Version
To activate a full version of NetSim, you should select the I want to activate NetSim option from the NetSim 
Activation Wizard dialog box and click Next. When prompted, enter the e-mail address and password associated 
with your Boson.com account. If you have not previously created a Boson.com account, you can create one from 
the Boson Online Account page (www.boson.com/Account/Default.aspx).

www.boson.com/netsim-cisco-network-simulator
www.boson.com/netsim-cisco-network-simulator
www.boson.com
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You will then be required to enter your activation key(s) to activate NetSim and to unlock the lab packs you 
purchased. After entering your activation key(s), click Activate.

The activation key(s) should be in the purchase receipt you received via e-mail, or you can find the receipt online 
on your Boson Online Account page (www.boson.com/Account/Default.aspx). To activate a full version of NetSim 
online, you must have an active Internet connection; if you do not have an active Internet connection, you can use 
manual activation to activate offline.

If you have previously activated NetSim with another key and would like to see that key, you can clear the Hide 
previously activated NetSim keys option; the Hide option is enabled by default. Additionally, if you have multiple 
keys that you would like to use to activate NetSim, you can click the Add Field button to add fields to the dialog 
box. If you open NetSim and are not prompted to activate, either because you previously used the Demo version 
or because you activated with a different activation key, you can click Help > Activate Keys to open the Activate 
Keys dialog box. You can click the Credentials button to verify that the associated account is your Boson.com 
account. 

If necessary, click Close to proceed to the full version of NetSim.

After a successful activation, the lab packs will be updated and NetSim will be ready for you to use. Installed labs 
are made available (unlocked) depending on the activation key used to activate the product. A small lock icon ( ) 
is displayed next to unavailable labs. To make locked labs available, you will need to purchase and enter the new 
activation key; then, more labs and a larger command set become available. 

https://www.boson.com/Account/Default.aspx
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Guided Tips
After you have activated NetSim (either the Demo version or a full version), you will see various dialog boxes 
with useful information about the features of NetSim. These tips will guide you through the Home panel, the Labs 
panel, the Network Designer panel, and the Lab Compiler panel.

Home Component Tips
The Home Component Tips highlight and describe aspects of the Home panel. You can read the tips within 
the dialog box, and you can see the areas described within the text by looking for the highlighted portion of the 
screen. In the following graphic, the four navigation buttons are highlighted in the lower-left corner of the screen:

You can scroll through the tips by clicking the Back and Next buttons. If you do not want to view the tips the next 
time you launch NetSim, you can disable the tips by selecting the Disable Tips check box.
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Lab Component Tips
The Lab Component Tips highlight and describe aspects of the Labs panel. You can read the tips within the dialog 
box, and you can see the areas described within the text by looking for highlighted portion of the screen. In the 
following graphic, the available locked and unlocked labs area is highlighted:

You can scroll through the tips by clicking the Back and Next buttons. If you do not want to view the tips the next 
time you launch NetSim, you can disable the tips by selecting the Disable Tips check box.
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Designer Component Tips
The Designer Component Tips highlight and describe aspects of the Network Designer panel. You can read the 
tips within the dialog box, and you can see the areas described within the text by looking for highlighted portion of 
the screen. In the example below, the NetMap area is highlighted:

You can scroll through the tips by clicking the Back and Next buttons. If you do not want to view the tips the next 
time you launch NetSim, you can disable the tips by selecting the Disable Tips check box.
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Compiler Component Tips
The Compiler Component Tips highlight and describe aspects of the Lab Compiler panel. You can read the tips 
within the dialog box, and you can see the areas described within the text by looking for highlighted portion of 
the screen. Any custom labs that you have created or are creating will appear in the section highlighted in the 
following graphic:

You can scroll through the tips by clicking the Back and Next buttons. If you do not want to view the tips the next 
time you launch NetSim, you can disable the tips by selecting the Disable Tips check box.

To close the Guided Tips, click Close and confirm that you want to exit the tips.

Begin a Lab
To begin a preloaded Boson NetSim lab, perform the following steps:

1. On the navigation pane, click Labs. 

2. On the Standard tab, double-click the lab you want to open. 

3. After you have loaded a lab, click the Lab Instructions tab and read through the lab instructions.
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4. From the Devices drop-down menu in the Consoles section, select the device(s) that you need to 
configure in order to complete the lab and follow the steps in the lab.

5. When you have completed the lab, click the Grade Lab icon ( ) on the toolbar to ensure that you have 
completed the lab successfully.

6. You can choose to save your configurations by selecting the appropriate Save option from the File menu. 
There is more information about saving device configurations in the Network Designer section or the 
Quick-Launch Toolbar section of this manual.

Menus
The menu options in NetSim 11 enable you to easily navigate through the labs, the NetMap and Network 
Designer, the Lab Compiler, the Consoles section, and more. These menus include the Menu Bar and the Quick-
Launch Toolbar.

Menu Bar

File Menu
The options in this menu tree enable you to open configuration files, open topology files, save configuration files, 
save topology files, import and export labs, and exit the program.

New
This option opens a new topology in the Network Designer.

Open
This option enables you to select a file to open. The supported file extensions are *.lab and *.bsn.

Save
This option enables you to save your current lab or topology and configurations. Files are saved with the *.lab 
or *.bsn extension.

Save As
This option enables you to save your current lab or topology and configurations. Files are saved with the *.lab 
or *.bsn extension.

Save All
This option enables you to save all unsaved lab, topology, and/or configurations that are currently open. Files 
are saved with the *.lab or *.bsn extension.

Package Lab
This option is primarily for License Server users and enables those users to save the current lab. This option 
adds user data so that instructors know who submitted the labs.

Import
This option imports network configurations, a previously saved lab, a previously saved lab pack, or legacy 
NetSim files.

Export
This option exports the network configurations currently running in the simulator, a lab or lab pack created 
with the Lab Compiler, or the current topology in the Network Designer.
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Recent Saved Topologies
If you recently saved a topology, it will appear in this list. You can click a file name to open the topology.

Recent Saved Labs
If you recently saved a lab, it will appear in this list. You can click a file name to open the lab.

Recent Loaded Labs
If you recently loaded a lab, it will appear in this list. You can click a file name to open the lab.

Exit
This option closes the program.

Edit Menu
The options in this menu tree enable you to configure proxy settings and change your preferences.

Proxy Settings
This option enables you to configure proxy settings for an Internet connection.

Preferences
This option opens the Preferences dialog box, from which you can configure the appearance of NetSim, the 
user experience (including the layout and dialogs), and the proxy settings. You can also configure the lab to 
load with the instructions in a separate window (see more information in the Lab Instructions Tab section), 
and you can configure the lab to load with a tab open for all devices in the associated topology (see more 
information in the Lab Menu section). This also enables you to restore program defaults.

View Menu
The options in this menu tree enable you to alter the way you view the panels within NetSim.

Current Mode
This option enables you to select the way you view the consoles of the devices you are configuring in a lab. 
In Window mode, each device is accessible on the Consoles section of the Labs panel. In Telnet mode, each 
device is accessible through a separate Telnet window for each device.
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Current View
This option enables you to switch among the options on the navigation pane: Home, Labs, Network Designer, 
and Lab Compiler.

Toolbar
Clear this option to hide the Quick-Launch toolbar. Select this option to restore the Quick-Launch toolbar.

Status Bar
Clear this option to hide the status bar at the bottom of the screen. Select this option to restore the status bar.

Auto Collapse Tree
Clear this option to expand all options in the lab menu. Select this option to collapse all options in the lab 
menu.

Auto Hide Menu
When this option is enabled, press the tilde key (~) to hide or display the Menu Bar. To disable the auto hide 
functionality, clear this option.

Lab Menu
This menu tree enables you to perform all the functions you need once a lab is loaded.

Load Lab 
After you select a lab from the navigation pane, click this option to load the lab instructions, topology, and 
configurations. 

Grade Lab
After you have completed a lab, click this option to verify that you have completed the lab successfully.

Launch External Lab Viewer
Click this option to open the lab instructions in a new window. You can then move the instructions to a second 
monitor or place them beside, above, or below the original NetSim window. This feature provides multimonitor 
support so that you can view the lab document on one monitor while entering commands on a second 
monitor.

Launch External NetMap Viewer
Click this option to open the NetMap in a new window. You can then move the NetMap to a second monitor 
or place the NetMap, which displays the topology, beside, above, or below the original NetSim window. This 
feature provides multimonitor support so that you can maximize the use of your computer real estate and 
easily view the topology on one monitor while entering commands on a second monitor.

Paste Router Configuration
This option allows you to paste the running configuration from a real router into a device in NetSim. Selecting 
this menu option when a lab is loaded will open a dialog box into which you can paste or type the desired 
configuration. The configuration will be loaded into the active device in the NetSim interface.
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Open All Devices
Click this option to open a tab in the Consoles section for every device in the network of the currently loaded 
topology. You can selectively close individual devices by clicking the close icon ( ).

Designer Menu
The options in this menu enable you to create a new topology and modify existing ones. You can add devices and 
connections to the topology in Network Designer, and you can also click and drag the devices to rearrange your 
simulated network.

New Topology
This option enables you to begin designing a new topology. 

Clear Topology
This option enables you to clear the topology you are creating. You will be asked to confirm that you want to 
clear the topology.

Add
This option enables you to add devices and connections to your topology. Clicking Add > Device will 
open the Add Device dialog box, from which you can choose the device you want to add. Clicking Add > 
Connection after you have added at least two devices and selected one on the topology will open the New 
Connection dialog box, from which you can choose the connection type and interfaces.

Compiler Menu
The options in this menu tree enable you to create a new lab pack for personal or instructional use.

New
This option enables you to select a new custom lab pack, a new lab, or a new section. To view the new lab 
pack, click the Lab Compiler button. More information can be found in the Compiling a Lab section of this 
manual.

Edit
This option enables you to edit the title of previously created custom sections or lab packs and enables you to 
edit previously created custom labs.

Delete
This option deletes the selected lab pack, section, or lab. You will be asked to confirm that you want to delete 
the selected component.

Wizard
This option launches the Lab Compiler Wizard, which enables you to easily compile a lab pack for personal or 
instructional use.

Help Menu
The options in this menu tree enable you to find out more information about the Boson NetSim Network Simulator 
and how to find support if you need it.
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Guided Tips
This option opens the Guided Tips. The Guided Tips appear when you first open and activate NetSim and 
guide you through the various features of NetSim. You can scroll through the tips by clicking the Back and 
Next buttons, and you can disable the tips by selecting the Disable Tips check box and confirming that you 
want to disable them. To see more details about the Guided Tips, see the Guided Tips section of this manual.

Users Manual
This option opens the Boson NetSim User Manual, the document you are reading now, which guides you 
through the features and functionalities of NetSim.

Support
This option displays frequently asked questions (FAQs) on the Boson NetSim support page (www.boson.com/
support/netsim-support-topics), allows you to save your current log files in the *.zip format, and allows you to 
submit a ticket through your Boson.com account.

Activate Keys
This option opens the Activate Keys dialog box. From here, you can activate additional versions of NetSim 
and the associated labs.

Check for Updates
This option closes NetSim and downloads any available updates.

About Boson NetSim
This option displays basic information about NetSim, including the version and company information.

Release Notes
This option displays information about the changes included in the current and previous releases of NetSim. 
The release notes are shown after the program has been updated. You can choose to not have the release 
notes appear after the program has updated by clearing the Display release notes after application 
updates check box. You can change the option at any time.

Quick-Launch Toolbar
Icons in the Quick-Launch toolbar are enabled or disabled depending on the pane in use.

New Topology
Click the New Topology icon ( ) to open the Network Designer and begin creating a topology.

Open File
Click the Open File icon ( ) to open a supported file. Supported file types are *.lab and *.bsn.

Save
Click the Save icon ( ) to save your current lab progress (*.lab) or configurations and topology (*.bsn).

Save All
Click the Save All icon ( ) to save all changes, including changes to devices in the Network Designer and 
changes to their configurations.

Grade Lab
Click the Grade Lab icon ( ) to grade the currently loaded lab.

http://www.boson.com/support/NetSim-Support-Topics.html
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Console to Device
Click the Console to Device icon ( ) to open a device from the NetMap in the Consoles section.

Zoom In
Click the Zoom In icon ( ) to increase the size of devices on the NetMap or on the active topology in Network 
Designer.

Zoom Out
Click the Zoom Out icon ( ) to decrease the size of devices on the NetMap or on the active topology in Network 
Designer.

Add New Device
Click the Add New Device icon ( ) to add a new device to the to the active topology in Network Designer.

Add New Connection
Click the Add New Connection icon ( ) to add a new connection between two devices on the active topology in 
Network Designer.

Delete Selected
Click the Delete Selected icon ( ) to delete a selected device from the active topology in Network Designer.

Clear Topology
Click the Clear Topology icon ( ) to delete all devices and connections from the active topology in Network 
Designer.

Start Simulator
Click the Start Simulator icon ( ) to load the active topology into the simulator, open the Consoles section, and 
begin configuring device. This option is disabled in Demo mode and in labs that are included in NetSim.

Stop Simulator
Click the Stop Simulator icon ( ) to stop the simulator and to reopen Network Designer, where you can 
reconfigure the devices and connections. This option is disabled in Demo mode and in labs that are included in 
NetSim.

Launch Lab Compiler Wizard
Click the Launch Lab Compiler Wizard icon ( ) to launch the Lab Compiler Wizard.

Move Selection Up
Click the Move Selection Up icon ( ) to move the selected lab pack, lab section, or lab up a position in the Lab 
Tree. 

Move Selection Down
Click the Move Selection Down icon ( ) to move the selected lab pack, lab section, or lab down a position in the 
Lab Tree.

Check for Updates
Click the Check for Updates icon ( ) to force Boson NetSim to check for updates.
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Edit Application Preferences
Click the Edit Application Preferences icon ( ) to configure preferences such as appearance and user 
experience.

Open User Manual
Click the Open User Manual icon ( ) to view the Boson NetSim 11 User Manual, which is the document you are 
currently reading.

Exit Boson NetSim
Click the Exit Boson NetSim icon ( ) to exit Boson NetSim.

Navigation

Home
You can open the Home panel by clicking Home on the navigation pane. There are many components of this 
panel and various features that you can access from this panel. After NetSim loads, you can perform various 
tasks by clicking the name of a recently loaded topology or lab, selecting a quick option such as checking for 
updates or opening the NetSim 11 User Manual (this document), or accessing a different panel by clicking Labs, 
Network Designer, or Lab Compiler. 
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Saved Files
From this section, you can quickly load a saved topology, saved lab, or recent lab.

Welcome
From this, the largest section, you can load a lab, create a new topology, compile a custom lab, and more. 

News
This section displays updates and special offers from the Boson Web site (www.boson.com). You can scroll 
through this section to see the latest news and information, and you can click more to view the related offer on 
the Web site. If you are not connected to the Internet, you might not see any news in this section. To see the latest 
news from Boson, make sure that you are connected to the Internet.

Labs
You can open the Labs panel by clicking Labs on the navigation pane. This panel contains three sections: the 
Lab Navigation section, the Lab Instructions / NetMap section, and the Consoles section. You can click and 
drag the splitter control between the Lab Instructions / NetMap section and the Consoles section to increase or 
decrease the size of those sections.

www.boson.com
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Lab Navigation
There are four main sections for navigating the lab tree: Select Lab Tree, Search Labs, Available Labs, and 
Lab Description.

Select Lab Tree
There are several lab trees available to you. The default selection is Standard. Standard labs are labs written 
with the intent to give students thorough practice with commands found in Cisco’s Official Student Lab Guide. 
Courseware labs accompany Boson’s Courseware product and will be locked unless you have purchased 
activation keys for the specific labs. Courseware labs are available for purchase on the Courseware page of 
the Boson.com website (http://www.boson.com/courseware-cisco-curriculum). The Expiring CCNA selection 
is available for a limited time. This lab tree organizes labs according to the ICND1/ICND2 topics that expired 
in August and September of 2016. Other than some lab titles and organization, there is no difference in the 
labs here and the labs in the Standard lab tree. The Custom lab tree displays labs that you create or that 
are provided by an instructor. To learn how to compile your own labs using NetSim, see the Compiling a Lab 
section of this manual. The sections on this tab are the same as the sections on the Standard tab.

Search Labs
You can use the Search Labs section to search for a specific term within a lab description. You can search 
throughout all the available labs. For example, if you want to test your Network Address Translation (NAT) 
skills on labs dealing with NAT, you could type NAT in the search box and press the Enter key. You will see 
labs addressing NAT from the ICND1 Stand-Alone, Sequential, and Scenario lab packs, among others. Note 
that although the search returned results from additional lab packs, only labs from the currently activated 
version of NetSim will be available.

http://www.boson.com/courseware-cisco-curriculum
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Available Labs
There are over 200 labs in NetSim 11, and these labs are arranged in specific categories. The lab packs are 
Demo, ICND1, ICND2, ROUTE, SWITCH, TSHOOT, and Supplemental. To open a lab on the NetMap tab 
and in the Consoles section and to view the lab instructions, double-click the lab or select the lab and click 
Lab > Load Lab. You can expand or collapse the menu items by clicking the arrow next to each category.

Lab Description
The information in this section contains a brief description of the lab. Click an individual lab to view summary 
information about the lab. 

Lab Instructions / NetMap Section

Lab Instructions Tab
Until you load a lab, this section is blank. When you load a lab, the instructions appear here. You can scroll 
through the instructions as you work through the lab, and you can increase or decrease the size of the 
content with the zoom controls or by clicking and dragging the splitter control between the Lab Instructions / 
NetMap section and the Consoles section. 

You can type text into the search box to find specific terms in the lab. You can click the down arrow on the far 
right of the search box to choose to match the whole word only or to match case. Use the left and right arrows 
next to the search box to find the terms you are searching for throughout the document.

Note: If you have selected to match case, for example, and then decide to match the whole word only and 
not case, you must click Match case again to remove it as a selected search parameter.

You can also launch the external lab viewer to view the instructions in a separate window. You can launch the 
external lab viewer by clicking Lab > Launch External Viewer or by clicking the dialog box launcher icon  
( ) on the Lab Instructions tab.

NetMap Tab
You can view the topology of the currently loaded lab on this tab. To configure a device, right-click the device 
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and click Configure in Simulator; the device will open in the Consoles section. If you cannot see all the 
devices in the topology, you can launch the external NetMap viewer ( ) to view the NetMap in a separate 
window. You can also use the zoom controls on the Quick-Launch toolbar or click and drag the splitter control 
between the Lab Instructions / NetMap section and the Consoles section to expand it.

Note: If you have a scroll button on your mouse, you can use it to increase or decrease the size of the 
devices in the NetMap section. You can also click and drag within the section to reposition the 
topology.

The NetMap is the read-only view of the topology currently running in the simulator. If you wish to edit a 
custom topology, you can do so by accessing it in the Network Designer.

Consoles Section
After you have opened a lab from the Standard tab or the Custom tab, you can view the device consoles and 
begin performing the lab steps. You will see the console window, the Devices drop-down menu, the Settings 
button, and device tabs.

Note: To ensure that you can see the available device consoles, click the arrow next to Consoles or  
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 click and drag the splitter control between the Lab Instructions / NetMap section and the  
 Consoles section.

Console Window
From the console window, you can modify the devices and perform the steps in the instructions. The devices 
in the lab can be accessed from the drop-down menu at the top of the section or from the lower tab menu. 
Select a specific device to begin performing the lab steps on that device.

Settings Button
The Settings button at the top of the Consoles section enables you to customize the appearance of the 
console window. You can select the font family, size, and weight and change the foreground and background 
colors. Click OK to apply the settings or Cancel to cancel the changes.

Note: Fixed-width fonts such as Courier New are highly recommended. With fixed-width fonts, output 
remains properly aligned and is easier to read and interpret.

SDM Button
The SDM button, when available, enables you to access NetSim Router and Security Device Manager (SDM). 
SDM is used in certain standard labs that are included with NetSim. This feature, available from a workstation 
only, is visible only in certain labs and is not available for custom labs.

Network Designer
You can access the Network Designer by clicking Network Designer on the navigation pane. There are three 
sections, Recent Devices, Available Devices, and the NetMap. The Recent Devices section shows the five 
devices you most recently added to the NetMap. The Available Devices section shows all devices that are 
available to add to the NetMap; you can use the options here to create a customized network topology with 
devices such as routers, switches, and PC workstations and with connections such as FastEthernet, Serial, and 
Frame Relay connections. Click and drag devices from the Recent Devices section to the Available Devices 
section to the NetMap. You can use the Network Designer to modify a topology by adding, editing, and deleting 
devices and connections; when you save and load a topology, the topology will appear on the read-only NetMap 
tab.
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The Network Designer panel is shown below:

Creating a New Topology
If you are creating a custom lab or want to gain extra experience with new topologies, you can use NetSim to 
create topologies with up to 100 devices. Note, however, that larger topologies might cause slow performance 
on computers that do not have sufficient processing power and memory. You can use this feature to create a 
topology file (*.bsn) that can be used in a custom lab. To learn more, see the Compiling a Lab section of this 
manual or open and perform the NetSim Topology Demo lab for a walkthrough of the feature.
To create a new simulated network topology, perform the following steps.
1. Click Network Designer on the navigation pane.
 Note: You can rename a New Topology tab by double-clicking the current name on the tab and  

 modifying it.

2. Add devices, including routers, switches, workstations, and IP phones, to the topology.

3. Add connections, including Serial, FastEthernet, and Frame Relay connections, between the devices you  
 added to the topology.
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Add Devices

Add a Router
1. Click the Add New Device icon ( ) on the toolbar.

2. Choose a router from the resulting Add Device dialog box. The menus for the available devices are 
minimized by default, but you can expand them by clicking the arrow next to each category. 

 

3. Select the number of add-ons (if available) and the type of connection (if available) for each add-on.

4. Choose a name for the router; you can use the default name or type a name in the text box. You can 
rename a device if desired by clicking the name in the NetMap and modifying it.

5. Click Create Router.

6. Add any additional desired devices to the network.

Add a Switch
1. Click the Add New Device icon ( ) on the toolbar.
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2. Choose a switch from the resulting Add Device dialog box. The menus for the available devices are 
minimized by default, but you can expand them by clicking the arrow next to each category. 

 

3. Choose a name for the switch; you can use the default name or type a name in the text box. You can 
rename a device if desired by clicking the name in the NetMap and modifying it.

4. Click Create Switch.

5. Add any additional desired devices to the network.

Add a Workstation
1. Click the Add New Device icon ( ) on the toolbar.

2. Choose a workstation from the Other Devices category in the resulting Add Device dialog box. The 
menus for the available devices are minimized by default, but you can expand them by clicking the 
arrow next to each category. 

3. If you have added the WinPC device, select a PC option if desired. You can choose from 
TFTP Server, AAA Server, and VPN Client). Traffic Generator is only configurable by Boson 
programmers.
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4. Choose a name for the workstation; you can use the default name or type a name in the text box. You 
can rename a device if desired by clicking the name in the NetMap and modifying it.

5. Click Create PC.

6. Add any additional desired devices to the network.

Add an IP Phone
1. Click the Add New Device icon ( ) on the toolbar.

2. Choose an IP phone from the Other Devices category in the resulting Add Device dialog box. The 
menus for the available devices are minimized by default, but you can expand them by clicking the 
arrow next to each category.

 

3. Choose a name for the phone; you can use the default name or type a name in the text box. You can 
rename a device if desired by clicking the name in the NetMap and modifying it.

4. Click Create ���1.

5. Add any additional desired devices to the network.

Add Connections
To complete the network, right-click each device on the NetMap. You will see a menu with four options: 
Configure in Simulator, New Connection, Existing Connections, and Delete. 

Configure in Simulator

When the topology is loaded into the simulator, clicking this option opens a console session to the selected 
device. 

New Connection

Configure a new connection for a device by performing the following steps:
1. Click the Add New Connection icon ( ) on the toolbar.
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2. In the New Connection dialog box, select an interface type from the Interface type drop-down box.

 

3. Select a local interface (if available), a remote device (if available), and a remote interface (if 
available).

4. After configuring the desired connection, click Connect. The new connection will appear on the 
NetMap.

Frame Relay Connections

To create a Frame Relay connection, perform the following steps:
1. Add routers to the topology; the routers to be included in the Frame Relay connection must have 

Serial interfaces.

2. Click the Add New Connection icon ( ) on the toolbar.

3. Select the Frame Relay radio button and the appropriate remote device.

 

4. Click Connect.
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5. In the Frame Relay dialog box, type a name for the Frame Relay node in the Name field.

 

6. Select an option from the Number of Nodes; the number represents the number of routers that will 
participate in the Frame Relay connection.

7. For each node, select the associated router and interface next to From: 1st Router and From: 
Interface. Note that the To: DLCI Destination field becomes populated with device names.

 Note: You must select a different router for each node.
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8. For each node, assign a DLCI value in each To: DLCI Destination field for the remote routers. For 
example, for the link from Router1 to Router2, you could use 102.

 Note: The DLCI value must be a numerical value.

 

9. Click Apply Settings. The exhibit below shows a completed Frame Relay connection: 
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Existing Connections

In the Existing Connections dialog box, you can see the type of device and the currently connected 
interfaces. You can access the Existing Connections dialog box by right-clicking a device on the NetMap 
and selecting Existing Connections.

CAUTION: There is no undo and no confirmation dialog box; be sure that you really want to delete a  
 connection before clicking Delete.

To delete a connection, click to highlight the connection and click Delete. To save the connection, highlight 
the connection and click Save.

Delete
CAUTION: There is no undo and no confirmation dialog box; be sure that you really want to delete the  

 selected device and associated connections before clicking Delete.

You can delete a connection by clicking the Delete Selected icon ( ) on the toolbar. This deletes the device 
and associated connection(s) from the topology.

You can also clear the NetMap by clicking the Clear Topology icon ( ) on the toolbar.

If you are creating a custom lab and compiling it for use by other NetSim users, see the Compiling a Lab section 
to continue creating the lab pack.
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Device Statistics
You can use your mouse to hover over a device on the NetMap and then click Device Statistics to view 
statistics that are specific for that device. In the exhibit below, you can see the statistics for Router1:

Save
You can save your topology by clicking the Save icon ( ) on the toolbar.

Lab Compiler
The Lab Compiler can be used to create, edit, and delete custom lab packs that contain personalized 
documentation, topologies, and configurations. For example, you can use the Lab Compiler to create a custom 
lab pack for a classroom setting and include a custom network topology, documentation, grading functionality, and 
beginning configurations for students to practice with. The Lab Compiler is included in every version of NetSim.

Classroom instructors commonly create custom labs that can be used both in the classroom and as homework 
assignments that follow the syllabus used in the course. Students can use homework assignments to practice the 
commands and configurations they learned in class and to prepare for the topics covered in the next day’s lecture. 
An instructor can add multiple labs to a single lab pack, covering a variety of concepts, and use custom labs to 
test the students’ knowledge about specific networking concepts.
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The Lab Compiler panel is shown below:

Compiling a Lab
A completed lab must contain two files: an XPS file for the instructions and a BSN file for the completed 
configurations.

XPS File
On most Windows systems, an XPS file can be created from a word processing program by using the Print 
feature. For example, in Microsoft Word, you can create and save a Word document and then select the Print 
option. You should be able to select Microsoft XPS Document Writer from the Printer Name drop-down 
box. You should save this in a folder with the title of your lab and in a place you will remember. You can then 
save all other associated files in the same location.

BSN Topology File
A BSN file can be created within NetSim. The BSN file contains a topology and, optionally, personalized 
configurations. To create the topology to be contained within the BSN file, see the Creating a New Topology 
section. If you save the topology without modifying the configurations in the simulator, the default settings will 
be included on all devices. 

BSN Loading Configuration File
To create a loading.bsn file, you should configure the loading configurations of the devices by performing the 
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following steps:
1. Ensure that the topology related to the lab is open in the Network Designer.

2. Click the Start Simulator icon ( ) on the toolbar to run the topology in the simulator.

3. Enter the commands necessary to achieve the beginning configuration state you desire on each device.

4. Click the Save icon ( ) on the toolbar to save the file as loading.bsn. 

Note: Boson recommends saving loading BSN files with the file name “loading” and saving completed 
BSN files with the file name “completed” so that you can easily distinguish loading BSN files from 
completed BSN files. 

BSN Completed Configuration File
The completed BSN file contains the completed configurations of all devices in your topology. To configure a 
completed BSN configuration file, perform the following steps:
1. Click the Open File icon ( ) to open the BSN topology file you previously created.

2. Click the Start Simulator icon ( ) on the toolbar to run the topology in the simulator.

3. Enter the commands necessary to achieve the final configuration state on each device. After a user  
 completes your lab according to the lab instructions you provide, the user will be able to grade the  
 commands he or she entered against the set of configurations you are currently creating.

4. Click File > Save As to save the completed.bsn file as a separate file from any other BSN files.

Creating a Custom Lab Pack
A lab pack is made up of one or more labs organized into sections. At least one section is required. To create a 
custom lab pack, you need to create a new lab pack, create a new section, and then compile a new lab. You can 
either use the Lab Compiler Wizard or create a lab pack manually. 

Using the Lab Compiler Wizard to Create a Lab Pack 
1. Click the Launch Wizard button at the bottom of the Lab Compiler pane.

2. Enter a title in the Lab Pack Title field, and click Next.

3. Enter a section title in the Section Title field, enter a lab title in the Lab Title field, and click Next.

4. Click the Browse buttons, and select the appropriate lab guide documentation (*.xps) and completed  
 network files (*.bsn) you created and stored on your computer. Click Next. 
 
Note: To learn how to create completed network files (*.bsn), see the BSN Completed Configuration File 
section in this manual.
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5. If desired, select a loading file (*.bsn) and click Next.

6. If desired, type a description and click Next.

7. Click Finish to return to the Lab Compiler main page.

After you create a lab pack by using the Lab Compiler Wizard, you should see the lab in the navigation pane. You 
can double-click a lab to open it, or you can click New Section or New Lab to continue creating the lab pack. 

Manually Creating a Lab Pack
1. Click Lab Compiler in the navigation pane.

2. Click New Lab Pack in the Getting Started section.

3. Enter a name for the lab pack. This is a lab pack title that will be displayed in the tree.

4. Click Save.

Adding a Section to a Lab Pack
1. In the custom lab tree on the left, select the title of the lab pack where you want to add a new section.

2. Click New Section in the Getting Started section.

3. Enter a name for the section. This is a section title that will be displayed in the tree.
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4. Click Save.

Adding a Lab to a Lab Pack Section
1. In the custom lab tree on the left, select the title of the section where you want to add a new lab.

2. Click New Lab in the Getting Started section.

3. Enter a name for the lab. This is a lab title that will be displayed in the tree.

4. Add a completed Boson Network file (.bsn).

5. Add a document. The only document files accepted are XPS documents (.xps).

You may optionally add a description and a loading BSN file to the lab. If neither file is desired, proceed to 
step 9.

6. Click Optional Fields in the Lab section.

7. Enter a description for the lab. A description is displayed for every lab underneath the Lab Tree.

8. Add a loading Boson Network file (.bsn). The topology in the specified loading file must match the  
 topology in the completed file from step 4. You will receive an error message if the topologies do not  
 match.
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9. Click Save.

10. To add additional labs to the lab pack section, repeat steps 1 through 9 until the lab pack section is  
 complete.

11. You can edit, add, delete, import, and export lab packs, sections, and labs with the options on the  
 Compiler menu and on the Quick-Launch toolbar.
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Troubleshooting

Some of my labs have locks next to them, and I can’t work through 
them
The activation key you purchased unlocks the labs and the commands that are included with that level of NetSim 
11. If a lab is unavailable with the activation key you purchased, you will see a small lock icon ( ) next to that lab. 
You can purchase higher-level activation keys, which will allow you to work through additional labs plus all labs 
unlocked by lower-level activation keys. All demo, CCENT, CCNA, and CCNP labs are unlocked when a CCNP-
level activation key is used. Additional labs are unlocked with the appropriate activation key; if you have questions 
about locked labs, please contact support@boson.com. Only the Demo labs are available without an activation 
key.

Commands seem to disappear when I press the Enter key on the 
number pad in Telnet mode
To ensure that the Enter key on the number pad works correctly every time you press it, you should open a 
command dialog box from the Run box in the Start menu, type telnet, press the Ctrl key and the right bracket key 
( ] ), type unset crlf, press Enter, and press Enter again. To see more information about this issue, see the related 
support topic on the NetSim Support page (www.boson.com/support/netsim-support-topics).

Telnet is not working on my Windows 8, Windows 7, or Windows Vista 
computer
Telnet is disabled by default on Windows 8, Windows 7, and Windows Vista. To enable Telnet for these operating 
systems, you should perform the following steps.

1. Open Control Panel from the Start menu.
2. In Control Panel, select the Programs or Programs and Features option.
3. On the Programs panel, click the Turn Windows features on or off option.
4. In the Windows Features dialog box, select Telnet Client and then click OK.
5. If you receive a Windows Security Alert, ensure that Private networks, such as my home or work 

network is selected and click Allow Access.

To see more information about this issue, see the related support topic on the NetSim Support page (www.boson.
com/support/netsim-support-topics).

The Custom tab is empty
You will see labs on the Custom tab of the Labs panel only if you have imported labs you received from another 
NetSim user or from an instructor or if you have created your own labs. To find out how to import labs or how to 
create your own labs, see the Compiling a Lab section of this manual.

mailto:support@boson.com
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Can I use key combinations as shortcuts?
The following table contains various shortcut key combinations you can use in NetSim:

Function Key
General Application Shortcuts

New lab Ctrl+N
Open lab Ctrl+O
Save lab Ctrl+S
Grade lab Ctrl+G
Launch External Lab Viewer Ctrl+L
Help Ctrl+F1
Close Alt+F4
Show/Hide Menu Bar Tilde key (~)

NetMap and Designer Shortcuts
Increase zoom Ctrl+Plus Sign (+)
Decrease zoom Ctrl+Minus Sign (-)

Console Shortcuts
Move to beginning of line Ctrl+A
Move to end of the line Ctrl+E
Move back one character Ctrl+B
Move forward one character Ctrl+F
Next command Ctrl+N
Previous command Ctrl+P
Break Ctrl+C
Move back 1 device Ctrl+Shift+Tab, or Ctrl+Comma
Move forward 1 device Ctrl+Tab, or Ctrl+Period
Jump to Device 1 F1
Jump to Device 2 F2
Jump to Device 3 F3
Jump to Device 4 F4
Jump to Device 5 F5
Jump to Device 6 F6
Jump to Device 7 F7
Jump to Device 8 F8
Jump to Device 9 F9
Jump to Device 10 F10
Expand device list Ctrl+D

Copyright © 1996 – 2017 Boson Software, LLC. All rights reserved. NetSim software and documentation are protected by copyright law.


	Guided Tips
	Boson NetSim Overview
	Using NetSim to Prepare for Your Certification
	Contact Information
	NetSim Technical Support
	License Solutions

	Getting Started
	System Requirements
	Product Activation
	Demo Version
	Full Version

	Guided Tips
	Home Component Tips
	Lab Component Tips
	Designer Component Tips
	Compiler Component Tips


	Begin a Lab
	Menus
	Menu Bar
	File Menu
	New
	Open
	Save
	Save As
	Save All
	Package Lab
	Import
	Export
	Recent Saved Topologies
	Recent Saved Labs
	Recent Loaded Labs
	Exit

	Edit Menu
	Proxy Settings
	Preferences

	View Menu
	Current Mode
	Current View
	Toolbar
	Status Bar
	Auto Collapse Tree
	Auto Hide Menu

	Lab Menu
	Load Lab 
	Grade Lab
	Launch External Lab Viewer
	Launch External NetMap Viewer
	Paste Router Configuration
	Open All Devices

	Designer Menu
	New Topology
	Clear Topology
	Add

	Compiler Menu
	New
	Edit
	Delete
	Wizard

	Help Menu
	Guided Tips
	Users Manual
	Support
	Activate Keys
	Check for Updates
	About Boson NetSim
	Release Notes


	Quick-Launch Toolbar
	New Topology
	Open File
	Save
	Save All
	Grade Lab
	Console to Device
	Zoom In
	Zoom Out
	Add New Device
	Add New Connection
	Delete Selected
	Clear Topology
	Start Simulator
	Stop Simulator
	Launch Lab Compiler Wizard
	Move Selection Up
	Move Selection Down
	Check for Updates
	Edit Application Preferences
	Open User Manual
	Exit Boson NetSim


	Navigation
	Home
	Saved Files
	Welcome
	News

	Labs
	Lab Navigation
	Select Lab Tree
	Search Labs
	Available Labs
	Lab Description


	Lab Instructions / NetMap Section
	Lab Instructions Tab
	NetMap Tab

	Consoles Section
	Console Window
	Settings Button
	SDM Button


	Network Designer
	Creating a New Topology
	Add Devices
	Add Connections

	Device Statistics
	Save


	Lab Compiler
	Compiling a Lab
	XPS File
	BSN Topology File
	BSN Loading Configuration File
	BSN Completed Configuration File

	Creating a Custom Lab Pack
	Using the Lab Compiler Wizard to Create a Lab Pack 
	Manually Creating a Lab Pack
	Adding a Section to a Lab Pack
	Adding a Lab to a Lab Pack Section




	Troubleshooting
	Some of my labs have locks next to them, and I can’t work through them
	Commands seem to disappear when I press the Enter key on the number pad in Telnet mode
	Telnet is not working on my Windows 8, Windows 7, or Windows Vista computer
	The Custom tab is empty
	Can I use key combinations as shortcuts?


